Tong quan vé cac tinh ndng mdi trong Acrobat 2017
Cap nhat: 06/06/2017

Adobe Acrobat 2017 hoan toan mdi la phién ban vinh vién méi nhat clia Acrobat. P6 1a giai
phap desktop hoan chinh dé lam viéc véi cac tai liéu PDF. Né don gian hda cong viéc hang
ngay PDF va bao gdm nhiéu cai tién nang suat khi lam viéc véi cac tép PDF tir may tinh dé

ban cua ban.

Dé dang so sanh cac files

V@i cong cu so sanh file mGi (Compare Files tool), ban cé thé tim ra su khac biét gira 2 file
PDF mot cach nhanh chéng.

Xem ban tom tat két qua da dugc scan vé su khac biét gilra cac tép dé dang

Dé dang di chuyén qua ting tai liéu dé xem lai moi sy khac biét bang cach st dung ché dé
xem tung trang moét hoac ting trang mot.

Loc va nhanh chdng thdy thay déi cua text, image, annotation, formatting, header/footer, or
background differences.

1. Chon Tools > Compare Files.
Note: O phién bdn trudc dugc goi la Compare Documents.

Compare Files ~ >

Select Files to Compare

Old File New File

E E

Select File - Select File -

D Compare text only

Help

2. Click Select File & goc trai va chon file ci ban muén so sanh. Click Select File bén phai
chon file m&i hon dé bat dau so sanh.
3. Click Compare.



4. Acrobat thé hién cac két qua trong tai liéu méi dugc cung cap dudi dang scan dé phan
biét su khac nhau.

Compare Files ~ E Side-by-Side  [B Old File New File /' Next Change W Filter v [E] Show X

LEGEND

Click ‘Next Change® to jump to the
next change in the report.

9/26/2016 3:56:20 PM

Compare Results

Summary i

OHd File: New File:
Chall 1.pdf Chall 2.pdf
allenges_v1.p S allenges_v2.py
10 pages (516 KB) 10 pages (515 KB)
8/5/2016 3:27:37 PM 8/5/2016 3:31:55 PM
Total Changes
Total Changes Content Other Changes
» I 1 1 Replacements 14 Styling
7 Insertions 0 annotatons
Shows Replacements 4 Deletions
Go to First Change (page 1)

5. Click vao nut Go to First Change dé xem tung chi tiét.
Chi tiét xem tai: Compare two versions of a PDF file.

Giao dién theo TAB dé xem nhiéu tép PDFs

Cac phién ban trudc ban phai m& nhiéu tép PDF trong cing mot phién lam viéc, nhung bay
gi& ban s& ma cac tép PDF dudi dang cac tab trong cung mét clra sé ing dung. Ban cé thé
chuyén d6i gilra cac tab & dau clra s6 bang cach nhdp vao tén tép dugc hién thj trong méi
tab. NUt trudc va nut ké ti€p dugc hién thi & trén cing bén phai dé ban diéu hudng qua cac
tab tai liéu khi s6 lugng tép PDF md& khong con phu hgp trong ché dé xem tai liéu.


https://helpx.adobe.com/acrobat/using/compare-documents.html
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Acrobat tu dong thay daéi kich thudc tab khi tai liéu khong vira vai clra s6 xem. Tat ca cac tép
tin da dugc md& nam & phia dudi cing cda trinh don Window. D& chuyén sang mét tai liéu
md& cu thé, hoac ban cd thé nhap vao tab cho tai liéu doc hodc chon tén tép cua no tur trinh
don Window.



Mew Window
Cascade Shift+Ctrl+)
Tile -

Minimize All Windows

Split
Spreadsheet Split

1 DRAFT_MFM_and_Release..pdate_2_MZ2_review.pdf
2 f1040.pdf
2 System requirements _..robat Standard DC.pdf
4 Document_Cloud_CHL.pdf
5 Binder1.pdf
& SavehAsAdobePDF.pdf
7 Acrobat DC usage Insi..nsights June 2015 pdf
+" & ShoppersStop_2013.pdf

9 Reader-Help _ Mobile-..nce_read-anywhere.pdf

e .

Theo méac dinh, giao dién theo TAB la ON. D& xem tirng tép PDF ma ban mé& trong mét cura
s6 Ung dung khac thay vi mét tab mdi, xéa hép chon Open documents as new tabs in the
same window (requires restart) dudi muc Edit > Preferences > General. Sau dé tat va md lai
Acrobat.

Preferences
Categories: Basic Tools
Commenting [ ] Use single-key accelerators to access tools
Documents Create links from URLs
Full Screen )
[ | Make Hand teol select text & images
Page Display [+ Make Hand tool read articles

[ | Make Hand tool use mouse-wheel Zooming
30 & Multimedia

Accessibility [ ] Make Select tool select images before text

Action Wizard [] Show online storage when gpening files

Adobe Online Services ] ] i
Show online storage when saving files

Catalog
Coler Management ( Open docurnents as new tabs in the same window (requires restart) ]
Content Editing — —

Tao danh sach dau dong mdéi (Create new bulleted lists)

Bay gid, Acrobat sé hién thi danh sach c6 dau dau dong va numbered list controls trong
bang Chinh stra Pinh dang PDF (Edit PDF Format). Bay gi& ban c6 thé tao cac danh sach cé



dau dau dong va dugc danh sé, chuyén déi mot khoan hién tai thanh mét danh sach cé dau
dau dong hoac dugc danh sé, chuyén lai danh sach sang van ban théng thudng va chuyén
déi danh sach tir mot loai danh sach sang mét loai danh sach khac. Acrobat bay gid cling
phat hién cac loai danh sach bé sung c¢é dau dau dong va dugc danh sé trong tai liéu cla
ban, néu cé, va hién thi ching & cudi trinh don kéo xuéng danh sach cé lién quan, dugc phan
tach bang mét dudng mau xam nhat.

Edit PDF> T edt T AddTest [af] Addimage o Link v [ CropPages [0 Header & Footer + o X
— )
FORMAT

Times New Roman -

Adobe recommends that you visit our website using a modern web or mobile browser. For 2
desktop browsers, you should also install the latest Adobe Flash Plaver to enjoy the full T
T
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experience.
This document covers system requirements for viewing and downloading content from the
Adobe website.
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Browser requirements
=Download requirements ]
Other requirements
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Browser requirements =115 - =

Adobe.com supports many popular web and mobile browsers. Most of the site is written in
HTMLS5 & CSS3. which most modem browsers support. To fully experience the Adobe website,
4 upgrade to the latest version of one of the following browsers:

¢ Microsoft Internet Explorer 9. or
later

+ Google Chrome

+ Mozilla Firefox

* Apple Safari, for OSX and i0S

The Adobe website no longer fully supports Microsoft Internet Explorer 8. and older IE browser
versions. Consider upgrading IE to a newer version. or use an alternate browser, listed above.
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For 10S. Adobe.com supports Safari 7 and newer. For Android. Adobe.com does not fully
support the older versions of the default WebKit browser. Consider using Chrome Mobile
browser, if you encounter problems.

Download requirements

Refer to the Adobe Download and Installation Help page for detailed guidelines and
instructions. Some download functions of adobe com may also require that JavaScript be enabled
in the browser. For Internet Explorer users, ActiveX controls may also need to be enabled.
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Ban cling c6 thé st dung ban phim dé thém mot muc trong danh sach. Vi dy, trudc mot
doan van, ban c6 thé nhap s6 'a' theo sau ddu ngodc déng ') va sau dé thém mot dau cach.
Acrobat tu dong chén mét danh sach danh sé bat dau vai "a)".

Dé dang quét sang PDF (Easier scan to PDF)

Céng cu Scanner tool ¢ giao dién don gian han. Giao dién mdi gilp ban dé dang quét cac
tai liéu gidy sang cac tép PDF bang cach sir dung cai dat mac dinh hoac tuy chon cai san. N6
cling giup ban dé dang diéu chinh cac thiét lap quét tir cing mét giao dién bang cach su
dung cac nut radio, biéu tugng banh rang, hoac ca hai.

D€ si dung Scanner tool, vao Tools > Create PDF > Scanner.



Create PDF ~ »

Create a PDF from any format

i . Scanner
Single File
Please select a scanner -
Multiple Files T .
Append to Existing File Select a file ¥ | Browse
Scanner
Scan using
Web Page (® Default Settings el
Black and White, Letter Size, 300 DPI, Front Sides
Clipboard Or use a predefined scan setting
Autodetect Color Mode
Blank Page O

O Black and White Document
O Color Document
O Grayscale Document

O Color Photograph

For more information, see Scan documents to PDF.

Dung ID ky thuat s6 (Use digital IDs)
Cong cu Certificates mdi hoan toan tool gilp cho viéc dang ky, xac nhan va xac minh tai liéu
bang ID ki thuét s6 dé dang hon bao gid hét.

Thiét 1ap dé dang. Tim ID k§ thuat s6 hién c6 cla ban tir tép, thé thdng minh hodc thiét bi m3
thédng b4o USB va dinh cdu hinh chiing mét cach dé dang dé ky.

Tuy chinh giao dién chit ky cta ban. Thém théng tin c6 gia tri vao chi ky cta ban, chang han
nhu biéu trung, ngay thang, vi tri hoac ly do ky két..

S dung chit ky hinh anh clia ban. V& chit ky cia ban hodac tai lén mét hinh anh dugc quét dé
thém no vao danh tinh ky thuat sé cta ban.

New digital ID configuration workflows

You can use existing digital IDs or create new ones. Based on whether a digital ID is available
on your machine or not, you will see one of the two workflows described below.

When no digital ID is available:


https://helpx.adobe.com/acrobat/using/scan-documents-pdf.html

1. When you create or click a signature field and no digital ID is available, you see the
following prompt.

Digital ID Configuration Required by

This signature field requires a digital signature identity.

Would you like to configure one now?

Help Configure Digital |0 Cancel

2. Click Configure Digital ID. The Configure a Digital ID for signing dialog is displayed.

Configure a Digital ID for signing X

A Digital 1D is required to Select the type of Digital ID:

create a digital
signature, The most secure
Digital ID are issued by = Use a Signature Creation Device
trusted Certificate %

authorities and are based on

secure devices like smart computer

card or token. Some are

based on files.

Configure a smart card or token connected to your

Use a Digital ID from a file

You can also create a new o o .
Digital ID, but they provide a E‘u@ Import an existing Digital ID that you have obtained
low level of identity as a file

dssurance.

@ Create a new Digital ID
H Create your self-signed Digital ID

®

3. Select the type of digital ID desired, click Continue, and then follow the wizard to create
the ID.
If you select Create a new Digital ID, the next set of options are displayed based on your
Operating System.



Select the destination ofthe new Digital ID

Digital IDs are typically ® Save to File

issued by trusted providers ® Q Save the Digital 1D to a file in your computer.

that assure the validity of

the identity.

Self-signed Digital 1D may

not provide the same level Save to Windows Certificate Store
o I

of assurance and may not Save the Digital ID to Windows Certificate Store to be shared

be accepted in some use with other applications.
cases.

Consult with your
recipients ifthis is an
acceptable form of
authentication.

® ( Back )( Continue )

On Windows

Select the destination ofthe new Digital ID

Digital 1Ds are typically ® Save to File

Ismied by trusted providers ® Save the Digital 1D to a file in your computer.
that assure the validity of
the identity.

Self-signed Digital ID may

not provide the same level r‘& Save to Apple Keychain

of assurance and may not o (\}@ Save the Digital 1D to Apple Keychaih to be shared with other
be accepted in some use applications.

CaASOS.

Consult with your
recipients if this is an
acceptable form of
authentication.

® ( Back )( Continue )

On Mac OS, you see a new option — Save to Apple Keychain

When one or more digital IDs are found:
1. When you create or click a signature field and one or more valid digital IDs are available
for signing, you see the following dialog box to choose your preferred digital ID.



Sign with a Digital ID

Choose the Digital ID that you want to use for signing:

Peter Baird ([Display the Digital ID source]) :
® @? Issued by: Peter Baird, Expires: 2021.05.19 View Details

o x_@ Peter Baird ([ Display the Digital ID source)) Vs Batalis

Issued by: Entrust, Expires: 2021.05.19

@ <ConﬁgureNew DigitiallD) (Cancel) ( Continue )

2. Select the desired ID and continue with the signing.

For more information, see Digital IDs.

Cai thién cong cu tim kiém (Improved tools search)

S dung céng cu tim kiém nang cao trong khung bén phai dé nhanh chong tim ra céng cu
ban can dé hoan thanh mét tac vu nhat dinh.

REEAT © 2

Find your tools here

Gui va quan ly cac danh gia dudc chia sé trén may Mac
(Send and manage shared reviews on Mac)

Bay gi& ban cé thé bat dau va tham gia cac bai danh gia chia sé dua trén SharePoint trén may
Mac dé cung cap va nhan phan héi nhanh chong.

For more information, see Hosting shared reviews on SharePoint or Office 365 sites.



https://helpx.adobe.com/acrobat/using/digital-ids.html
https://helpx.adobe.com/acrobat/using/host-shared-reviews-on-sharepoint-office-365-sites.html

Chon giao dién (Select a Ul theme)

Ngoai chGi dé Xam nhat, Acrobat va Acrobat Reader giG day cé mot chd dé Xam Bam mdi,
phu hop véi cac san pham Adobe Creative Cloud khéac, chang han nhu Photoshop, lllustrator
va Premiere Pro. Chi dé nay cung cdp mét trai nghiém thi gidc hap dan, dac biét la khi lam
viéc v8i mau sac phong phu va thiét ké. N6 cling lam cho Ung dung chéo don gian han bao
gid hét.

By default, the theme continues to be Light Gray. To change it to Dark Gray, go to View >
Display Theme > Dark Gray.

Home Tools TravelGuide.pdf @ Username ~

® 8 2 Q 2 ‘ © ¢

Find your tools here

IS

" | Create PDF

52 Edit PDF

T T TS

Export PDF
@ Comment
Organize Pages
5 Enhance Scans
Protect
2. Fill &Sign
Prepare Form

) Compare Files

Your current plan is Creative
Cloud

Learn More

Ghi chi nang cao (Enhanced commenting)

Cung cap va nhan phan hoéi nhanh, ré rang v&i cac cong cu nhan xét mdi va giao dién truc
quan, cam Ung than thién.

Customize the comment toolbar to see the features you use.

Easily change the color, font, or size of comment text.

Easily view and navigate through comments. You can organize comments by page, author,
date, type, checkmark status, or color. Filters also support quick management of comments.



Reply to sticky notes with a single-thread that presents all replies to an annotation in one
conversation.

Tap on fillable text fields to bring up the soft keyboard on touch-enabled devices.

Use keyboard shortcuts for commenting actions, including delete, replace, or add a note to
text. When you open the Comment tool, the text markup shortcuts are enabled by default.

Use the new highlighter pen to mark up scanned documents without needing to run OCR.

Easily change the color, font or size of comment text

Easily discover and modify text highlight color - the Color Picker is available on the Comment
toolbar.

& & & A D=

Fill Color

Opacity 1005

O

Text formatting tools appear automatically for typewriter and text box tools. The moment
you click anywhere on a page, the Text Properties pop-up menu appears below the Comment
toolbar.

g & & G & O =[Aa
Helvetica - 12 - .

T 7 T T T T

Easily view and navigate through comments

Page-based organization in the comments pane.



44 Comments %* AYASRID

Page 1 3 unread 3w "
Page 2 3 unread 3w

Page 3 3 unread 3w

Page 4 2 unread 20 A
Stephanie ...

T Strikethrough Text
4/8/2016 1219 PM
v 18

Stephanie ...

Send files -- Upload large files and
easily share with others,

4M16/2016 1:00 PR
v 1 a

Page 5 1 unread 1T A

Stephanie ...

T Strikethrough Text
4/8/2016 1223 PM

v 18

Reply to Sticky Notes with a single-thread experience

Each annotation is now equivalent to a conversation and all replies appear like a single-
thread experience.
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Vikrant ... ~
This Question need a closer look for

branding.

3/22/2016 Z:54 PM

Christy ... LY

| L I T
e Replace Text

Adobe Sign is the new name both Adobe
EchoSign and its successor, Adobe
Document Cloud eSign services.

3/28/2016 %35 AM |

Christy ...

=270 1)

3/28/2016 9:35 AM

prabhat
What about i05 and Android apps?

5/4/2016 T:39 PM

Vé bang cach sur dung Directink (Draw using Directink)

Acrobat da ho trg Microsoft's new Directink technology. N6 cho phép ban sir dung ngén tay
hoac mot cay but dé vé va viét tran tru hon trén cac tép PDF trén cac thiét bj Windows 10.

Xem trudc file (Preview files)

Xem trudc file va ma cac codng cu phd bién truc tiép ti ché dé xem Home. Khi ban nhap vao
tén file trong danh sach file gan day, bang diéu khién chi tiét xuat hién trong ngan bén phai
hién thi ban xem trudc hinh thu nhé cua file cung véi cac cdng cu thusng xuyén st dung.
Nhap dé ma mét cong cu hodc chon Remove From Recent dé xda file khoi danh sach file gan
day.
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Size

Yo KB

391 KB

48 KB

120 KB

103 KB

2.2 MB

66 KB

303 KB

125 KB

19 KB

17 KB

85 KB
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YR VAV W]

4/28/2017

1/20/2017

12/9/2016

9/22/2016

9/1/2016

7/11/2016

5/18/2016

3/26/2015

3/25/2015

2/24/2015

11/18/2014

@ Username -~

Location

Adobe Document Cloud
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